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Custom Documents
A Custom Document is a variant of a Linked Document in
which you can create a fully customized report on any set of
ad hoc elements, diagrams or packages. Individually or in
combination, from anywhere in the model, in any order you
choose, and in any format and style you select or design.
The granularity of the objects you choose depends entirely
on how you want to your document to be populated. A
Custom Document represents a range of model elements and
their properties, and every time you open the document the
content is dynamically refreshed from the model objects you
have included and from the template instructions.
A Custom Document can have three types of content:
· Boilerplate text from a document template - including a
title page, table of contents and paragraph text
· Dynamic content that is dragged into the document from
the Browser window, including packages, diagrams,
elements and features; you can bring in multiple objects
together if you want to maintain the same sequence as in
the browser window
· Static content that you type or paste into the document,
including additional images, tables, glossaries and similar
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Custom Documents are one of the easiest and most
compelling ways to produce high quality and flexible
publications, for compliance with project or contractual
obligations, or simply for internal use by other team
members.
A productivity feature of the Custom Document facility is
that you are able to refresh an entire document, or just a
particular inserted fragment that will dynamically update the
document, ensuring that it reflects the latest changes in the
repository. For those who have previously created
documents in their favorite word processor and have
manually exported and pasted into their documents diagram
images ( which, of course, are out of date the minute the
repository diagram is changed ) will welcome the ability to
have their document automatically updated and ready to
publish with minimal effort.
(c) Sparx Systems 2022

Page 5 of 39

Custom Documents

19 April, 2022

Creating Custom Documents is straightforward and you can
generate a professional and useful document within a few
minutes. The document can be saved within the repository
or exported to a variety of formats, including DOCX, PDF,
and RTF. To complement the documents, it is also worth
considering giving an audience access to a live model through WebEA or Prolaborate - that is part of the Pro
Cloud Server.

(c) Sparx Systems 2022
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Getting Started
Getting started with Custom Documents is straightforward;
this topic identifies and explains the steps you follow to
create a professional and useful document to save within the
repository or to export to file in a range of formats including
DOCX, PDF, RTF and HTML.
In brief, to create a Custom Document you:
1. Identify or create any document templates you want to
use in generating the Custom Document.
2. Select or create a parent Package or element to host the
Custom Document.
3. Open a new Custom Document, and provide a name.
4. Select a document template from a list, or choose 'none'.
5. Type in Static text and drag in Packages, elements,
diagrams or Features from the Browser window, as
Dynamic content. When you drag Dynamic content into
the document, you are prompted to select another
template or template fragment so that you can organize
the information on that object in a specific format.
6. Perform further editing and formatting on the document,
using the Document-Edit ribbon options and the left-hand
summary panel.
7. Print or save the document in the required format.

Identify Templates
(c) Sparx Systems 2022
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At two points in the process of creating a Custom Document
you can select a template to insert boiler plate text and
format the document content.
The initial template is to apply an overall document
structure and format, and other templates are used to provide
specific formatting for particular sections within the
document. You can use the system-provided templates,
templates that you or other users have created before, or
templates that you have created specifically for this
document. You need to have created and/or identified these
templates before you start. See the Template Prerequisites
Help topic.

Select or Create Parent Element
A Custom Document is hosted by an element in the model.
The direct method of creating a Custom Document also
generates a Document Artifact element to contain it, in a
selected Package. You might want to create this Package as
a container for all your Custom Documents.
You can also create almost identical documents as Linked
Documents, in which case you create and/or select the
parent element for the document. See the Create a Custom
Document Help topic.

(c) Sparx Systems 2022
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Create a Custom Document
In the Browser window, select the Package in which to
create the Custom Document, and select the 'Publish >
Model Reports > Custom Document' ribbon option. The
system prompts you to provide a name for the Custom
Document; when you do, the Document Artifact element is
created in the selected parent Package, and the document
editing view opens in the Enterprise Architect workspace.
See the Create a Custom Document Help topic.

Select Template
After the document editor opens a prompt displays for you
to select from a list of built-in and user-defined templates.
The templates might include those you have specifically
created for your Custom Documents in general, or for this
document in particular.
The selected template will act as the backdrop for the whole
document, and would typically provide a title page, a table
of contents and placeholders for static or dynamic content,
in addition to the styles. Such templates are likely to have
been created as Linked Document templates.
You can choose to not use a template by selecting 'none'.

(c) Sparx Systems 2022
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See the Template Prerequisites Help topic.

Add Static Content
You add Static content to the document by simply typing or
pasting text directly into the editor screen and manually
applying styles and formatting. Enterprise Architect has a
fully-featured document editor that helps you to enter and
edit the content of the document. The features of the editor
are accessed via the Document-Edit ribbon, which is
enabled when a document is open in the workspace.
You incorporate Static content to explain or connect the
Dynamic text. For example, you might want to describe the
process by which you created Requirements from the notes
from stakeholder workshops. This image is an example of
Static content pasted into a document and formatted.

(c) Sparx Systems 2022
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See the Add Static Content Help topic.

Add Dynamic Content
Dynamic content is a set of links to any number of
Packages, diagrams, elements and Features (attributes,
operations and receptions) dragged from the Browser
window onto the open document. Whenever you drag an
item from the Browser window into a document, Enterprise
Architect displays the 'Add Content to Document' dialog to
prompt you to select how to insert and format the item.

(c) Sparx Systems 2022
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For a model element such as a Package, element or Feature,
you can select the (default) option of 'Dynamic Content' in
the 'Insert as' field. This adds the object information to the
document. The prompt also provides a list from which you
can select a template or template fragment to format that
specific information within the document. The list of
templates can be filtered to present only those that are
user-defined, or system-provided, or technology-provided,
or to show all available templates. You make your selection
by clicking on the appropriate radio button under the list.
You can also select an option in the 'Insert As' field to add
the model element as a hyperlink, which enables the reader
to access the object in the Browser window.
You can incorporate diagrams either as hyperlinks or as
Diagram Images, by selecting the appropriate option.

See the Add Dynamic Content Help topic.
As you add Dynamic content to a Custom Document, a
'Content' panel displays on the left of the document editor.
This panel is discussed in the next section.
(c) Sparx Systems 2022
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Using the Content Panel
As you add Dynamic content to the Custom Document, the
left-hand 'Content' panel lists the items that have been
inserted as either 'Dynamic Content' or 'Diagram Image' items added as hyperlinks are not included in the panel. The
items are listed in the order in which they were inserted into
the document. By right-clicking on an item name in the list
you can select options to:
· Change the template applied to the item in the document the 'Add Content to Document' dialog displays for you to
select another template
· Highlight the item in the body of the document
· Update that item alone as a dynamic section of the
document
· Locate and highlight the item in the Browser window
· Delete the item from the document
See the Manage Custom Documents Help topic.

Print or Export Document
A Custom Document can be viewed by other team members
using Enterprise Architect. It can also be exported to a
variety of formats and so made available to a wider
(c) Sparx Systems 2022
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audience. To export the document, click on its Document
Artifact element in the Browser window and select the
ribbon option:
Document-Edit > File > Save As (Export to File)
The 'Save as' dialog displays, through which you can save
the document to an appropriate location and in one of a
variety of formats, including DOCX, PDF, RTF and HTML.
If the Pro features of the Pro Cloud Server have been
enabled, the document will be available for view by a wider
audience through a browser in WebEA and in Prolaborate,
without the need to export it.
You can also print the document by clicking on the
Document Artifact and selecting the ribbon option
Document-Edit > File > Print.
See the Publish a Custom Document Help topic.

(c) Sparx Systems 2022
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Template Prerequisites
Enterprise Architect provides a wide range of document
templates that enable you to define the format and structure
of your reports and documents. A big advantage of these
templates is that you can re-use them for different instances
of the same document or for different documents, helping
you to implement document standards across the
organization, and maintain consistency of style, format and
presentation in your document library. For example, it might
be part of your project methodology to create a 'Concept of
Operation' document at the start of a project, and the same
template could be used for a number of projects.
Two types of template can be used with Custom
Documents:
· Linked Document templates - these templates apply to the
Static content and control the main structure of the
document, including title page, table of contents and
headings and styles; for example, a 'Concept of Operation'
template
· Document Generation templates - these templates can be
applied to the Dynamic content you insert from the
Browser window, and are typically specific to a particular
style of presentation; for example, listing Requirements
and their properties in a table, or showing a diagram with
a list of the elements that it contains

(c) Sparx Systems 2022
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Productivity gains can be achieved by using a Corporate
template for a document type; for example a 'System
Requirements Specification' or a 'Solution Architecture
Document' with appropriate styles, tables of content and
boiler plate text. Enterprise Architect provides a large
number of system (built-in) Linked Document templates and
Document Generation templates to use, but you can also
copy and modify the system templates or create entirely new
templates to address particular organization, project or team
standards. You can achieve this using the built-in template
editor, for Linked Document templates, Document
Generation Templates and Template Fragments.

(c) Sparx Systems 2022
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Create a Custom Document
A Custom Document is a form of Linked Document, and
therefore is associated with an element in the model.
However, Linked Documents usually contain static
information specific to the host element, whereas the main
feature of a Custom Document is that it contains
automatically refreshed information on several objects from
anywhere in the model. Therefore, the main method of
creating a Custom Document also generates a Document
Artifact element to host the document, in a selected
Package.

Access
Ribbon

(Click on selected parent Package.)
Publish > Model Reports > Custom
Document

Create the Document
When you select the ribbon option, the system displays a
prompt to provide the document name.
(c) Sparx Systems 2022
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After you type in the name and click on the OK button, the
system opens the document in the document editor and
prompts you to select any document template you have
decided to use as the base template, to provide the cover
pages, tables of content, styles and boiler plate text for the
whole document.

If you do not want to use a document template you can
select 'None' from the drop-down.
When you click on the OK button, the document is
populated with any template boiler-plate text and fields, and
the document is ready for you to add content.

Alternative Method - Use a Document
Artifact
You can mimic the main approach by creating your own
Document Artifact element and then creating a Linked
(c) Sparx Systems 2022
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Document on it, which you can also populate with Static
and Dynamic content.
Firstly, open a diagram and drag a 'Document' icon from the
'Documents' page of the Toolbox onto that diagram. Give
the Artifact element a name. Double-click on the Artifact to
open the Linked Document editor (or click on the Artifact
and select the 'Design > Element > Manage > Edit Linked
Document' ribbon option). Enterprise Architect will then
prompt you to select a template for the overall document (as
for the Publish ribbon icon).

(c) Sparx Systems 2022
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Add Document Content
When you work with Custom Documents you can add
content in several different ways. This provides you with
great flexibility and enables you to:
· Craft a document tailored exactly to your needs
· Create an expressive narrative that will appeal to your
audience, with the added benefit of the document content
being updated automatically whenever the content in the
repository changes.
A Custom Document can contain three types of content:
· Content contained in the document template - including a
title page, table of contents and paragraph text
· Dynamic Content that is dragged into the document from
the Browser, including Packages, diagrams, elements and
features
· Static Content that a user types or pastes into the
document, including static images
We will look at these three types of content in the Document
Templates, Add Dynamic Content and Add Static Content
Help topics.

(c) Sparx Systems 2022
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Add Dynamic Content
Dynamic content refers to content that can be added by
dragging and dropping items from the Browser window onto
the open document. This is a great facility of a Custom
Document, because whenever the document is accessed, the
item information is automatically refreshed from the model.
Any item in the Browser window can be added to the
document, including Packages, diagrams, elements and
Features (attributes and operations). Multiple items can be
dragged at the same time; these would be inserted based on
their order in the Browser window.
Great flexibility is provided by allowing you to select a
document generation template for each item you add to the
document. For example, you might add a Stakeholder
Package containing a list of Stakeholder elements, and use a
template that lists the Stakeholders in separate paragraphs.
This allows you to create a compelling publication that
contains up-to-date selected information from the model in
the repository, 'injected' into appropriate places in the
document above, below or between Static content, and
rendered using user-specified templates.

Adding the Material
Whenever you drag an item from the Browser window into
a document, Enterprise Architect displays the 'Add Content
to Document' dialog to prompt you to select how to insert
(c) Sparx Systems 2022
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and format the item.

You can drag and drop an item into a document as Dynamic
content by selecting one of the options in the 'Insert As'
field:
· Dynamic Content - the item contents will be copied into
the document, rendered according to a selected document
generation template: for a model element such as a
Package, element or Feature, this is the default option
· Hyperlink - creates a link that a reader can follow to the
object or diagram in the Browser window (note, this is for
documents read online)
· Image Hyperlink - creates a hyperlink to an image artifact
of a diagram, in the model; the image artifact is created as
part of this process
· Diagram Image - this inserts the selected diagram as an
image in the document

(c) Sparx Systems 2022
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If you are creating a number of links (and, for Dynamic
content, using the same template) you can avoid displaying
the dialog each time. Create the first link and then press the
Ctrl key as you drag each of the subsequent objects onto the
document. The links are all of the first-selected type, until
you drag an object without pressing the Ctrl key; the dialog
displays again and you can change the 'Insert As' option.

Specifying a Template
Whenever you add an item from the Browser window to a
document, the 'Add Content to Document' dialog that is
displayed also prompts you to select a Document Generation
template or Template Fragment from the 'Select a
Document Template' list. You would select a template if you
have chosen to insert the item as Dynamic content. For
example, you might want to display an element's content as
a formatted paragraph with a heading and a list of features,
or as a labeled table showing the element's Name,
Description (Notes) and Status.

(c) Sparx Systems 2022
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The list of templates can be filtered to include only those
that are user-defined, or system-provided, or
technology-provided, or to show all available templates.
You make your selection by clicking on the appropriate
radio button under the list.
This image shows an example of items that have been added
as Dynamic content and rendered using a template that
displays the items in a table showing each item's Name,
Priority and Notes.

Inserted Material
Generally, you insert Dynamic content items into the
(c) Sparx Systems 2022
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Custom Document from the Browser window in sequence.
It is, in practice, possible to insert one dynamic item within
the section generated by another, but this presents several
complications in document generation and maintenance.
Therefore, if you do insert one item within another, a
warning message displays to makes sure you are aware of it,
and to allow you to cancel the insert if it is not intentional.

Keeping Track of Inserted Dynamic Items
As you add Dynamic content to a Custom Document, you
will notice that a 'Content' panel displays on the left of the
document editor, listing the items that have been inserted as
either 'Dynamic Content' or 'Diagram Image', in the order in
which they were added to the document. Items added as
'Hyperlinks' or 'Image Hyperlinks' are not included in the
panel.) You can manage the added dynamic content from
the context menu that displays when you right-click on each
of the item names in the panel.

(c) Sparx Systems 2022
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This panel is discussed in the Manage Custom Documents
Help topic.

Inserting the Wrong Item
If you find that you have inserted the wrong model object as
Dynamic content, you can right-click on it in the 'Content'
panel and delete the section. Alternatively, if you inserted
the item as a hyperlink (which is not listed in the 'Content'
panel) and/or you have only just inserted the item, you can
right-click on the text and select the 'Undo' option, which
immediately removes the whole item. The Undo option is
also available in the Document - Edit ribbon, under the 'Edit'
icon in the 'Edit' panel.

(c) Sparx Systems 2022
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Add Static Content
The main purpose of a Custom Document is to capture
up-to-date information from the repository via Dynamic
content, but you will also need to incorporate Static content
to explain or connect the Dynamic text. For example, you
might write some Static text describing the types of
Requirements and how some were derived from the analysis
of stakeholder requests, and then drag in a Package of
Requirements from the Browser window as Dynamic text
and apply a template that puts elements into the document as
a table.

You can create Static content by typing or pasting text
directly into the document and applying styles and
formatting. Enterprise Architect has a fully-featured
document editor that helps you to enter and manage Static
content in the document. The editor facilities are available
through the Document - Edit ribbon, which is automatically
enabled when a document is open in the workspace. This
(c) Sparx Systems 2022
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image shows some of the formatting options available from
the ribbon.

This image shows an example of Static content that has been
pasted into the document and is rendered according to the
styles defined in the Linked Document template. See the
Editing Documents and Templates Help topic.

Inserting Breaks, Headers, Footers and
Extras
Amongst the wide range of features for working with Static
content in a custom document are options to add page and
section breaks, headers and footers, tables of content,
footnotes, and paragraph and text formatting. There are also
several guides such as horizontal and vertical rulers.

(c) Sparx Systems 2022
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Inserting Static Images and Objects
Whilst many of the images in a Custom Document will be
inserted dynamically from the Browser window, there will
be occasions where you might want to add an image from a
local or network drive; for example, an organization or
project logo, or an image from another tool.
It is worth remembering that these too could be added to a
repository diagram and inserted as Dynamic content.

Inserting and Formatting Tables
Just as if you were using your favorite word processor, you
can insert tables and format them to suit the content,
including adding rows and columns, and changing border
style and cell spacing. These tables could be used in the
document preamble for sections such as versions of the
document, or audience, or in the body of the document. This
image shows some of the options for working with tables.
(c) Sparx Systems 2022
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Spelling and Thesaurus
When working with both Static and Dynamic content you
can configure Enterprise Architect to auto spell-check, and
you can also use an inbuilt thesaurus to find alternative
words to make your document richer. Spelling can be
configured by setting a number of options available from the
Document - Edit ribbon, as illustrated by this image.

Using Track Changes
The document edit facilities in Enterprise Architect allow
you to work collaboratively with other modelers. One
(c) Sparx Systems 2022
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feature that will help you when working with Static text in
Custom Documents is Track Changes. This allows you to
track the changes as you or others work with the document.
This image shows a Static part of the document where Track
Changes have been enabled and some text has been
changed; the deleted and added text is shown in red.

Baselines and Version Control can be used to 'track changes'
in the Dynamic parts of the document.

(c) Sparx Systems 2022
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Manage Custom Documents
As you add Dynamic content or Diagram Images to a
Custom Document, the name of each added item or diagram
is added to the 'Content' panel on the left of the document.
You can use these context menu options in the panel to
perform a number of operations on the listed items:
· Change the Template
· Highlight Section
· Update Dynamic Section
· Find in Browser
· Delete Section
These options are described in the remaining sections of this
topic.
The main body of the Custom Document editor also has a
context menu, providing the 'Update Dynamic Report
elements' option that will update all Dynamic content across
the document, ensuring that you have the very latest
information from the model. This context menu also
provides a number of common editing commands such as
Cut, Copy, Paste, Undo, Print and Zoom. Note that the
'Undo' option, when selected after a Dynamic content item
has been added, will remove the entire section created for
that item.

Change the Template
(c) Sparx Systems 2022
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This option allows you to change the document generation
template for the selected item. It is most useful when
re-factoring the document in response to, say, a review by
Stakeholders. For example, you originally used a template
for Requirements that listed each Requirement in a
paragraph style. A Stakeholder, after reviewing the
document, asks to see the Requirements listed in tabular
form. You would then use this option to switch to an
alternative template.

Highlight Section
This option highlights the formatted material from the
selected item in the Custom Document. This is very useful
for two reasons, in that it identifies where the item is
included in the document, and it shows exactly what
material has been added from the item.

Update Dynamic Section
The main characteristic of Dynamic content is that it drawn
from items in the model that are subject to frequent change.
As you read the document, an item might be updated by
another team member. To ensure that you are seeing the
latest instance of an item, select this option to refresh the
item details from the model.
(c) Sparx Systems 2022

Page 33 of 39

Custom Documents

19 April, 2022

There is also an option available from the context menu for
the main body of the Custom Document, to update all
Dynamic sections of the document at the same time, as
described earlier.

Find in Browser
This option locates the selected object in the Browser
window. As you develop your Custom Document and add
more and more sections it might not be obvious from
looking at the list what each item or diagram is and where it
came from in the repository. Select this option to locate the
Package, diagram, element or Feature (attribute, operation
or reception) in the Browser window.

Delete Section
This option removes the Dynamic content for the selected
section. An item might have been added to the document
that, for some reason, is no longer required. You can select
the option to remove that item from the document without
altering the other sections, regardless of whether they are
Static or Dynamic. At a later time, if necessary, you can
drag the item back in at the same point or a different point.
Note that Packages and elements inserted into a document
might have child objects, and if you delete the parent object
(c) Sparx Systems 2022
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from the document you will lose the child objects as well.
Therefore, when you select to delete an object with child
objects, a warning message displays to make you aware and
allow you to cancel the deletion if necessary.

Rearrange Content
Because a Custom Document contains template boiler-plate
text and Static text as well as Dynamic text, there is no
direct option for switching the Dynamic sections around you cannot take the fixed text into account that way.
The simplest option is to just click and drag the cursor over
text you want to move, use the 'Copy' or 'Cut' context menu
options, and then paste the text into the required location. If
this moves a section of Dynamic content, the relocation is
reflected in the left-hand panel after the document is saved.
You can also use the panel 'Highlight Section' option to
make sure that:
· The copied or cut section contains exactly the text and
Dynamic content you want to move, and
· The point to which you want to move the text does not sit
within the start or end of another Dynamic section
Simply right click on the item represented by the Dynamic
content in the panel, and select the 'Highlight Section'
option. This highlights all the text within that item's
Dynamic content. You can then select any appropriate text
that includes the highlighted section.
(c) Sparx Systems 2022
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In the panel, you then right-click on the item represented by
the Dynamic content before or after which you want to
insert the captured text, and again select the 'Highlight
Section' option. You can then see exactly where that section
starts and ends, and paste in the captured text where it does
not conflict with the highlighted section.

(c) Sparx Systems 2022
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Publish a Custom Document
Once you have created a Custom Document and added
Static and Dynamic content, you can share the document
with other modelers and stakeholders. A publication can be
created using the 'Document - Edit > File > File > Save As
(Export to File)' ribbon option.
Before you generate the document you might want to
refresh the Dynamic content to ensure it is up-to-date - see
the Manage Custom Documents Help topic.
The 'Save As (Export to File)' option helps you to save the
document to a file on a local or network drive in a variety of
convenient formats, including:
· PDF
· DOCX
· HTML
· RTF
· TXT
· SSE
When you select the option, a Windows-style 'Save As'
dialog displays on which you browse for the file location to
save the document into, and select the file format to apply.

(c) Sparx Systems 2022
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There are other ways in which a document can be made
available to stakeholders, depending on the Sparx platform
that you have set up. If you are using the Pro Cloud Server
and have 'Pro' features enabled, you can make your
document available to a wide audience, including
stakeholders outside the modeling teams, using two tools
that anyone with a Web Browser and the correct credentials
will be able to open.
· A link can be provided to a WebEA page that will display
the document (see the Add a Document Help topic in the
WebEA section)
· A link can be provided to a Prolaborate page that will
display the document (see the Prolaborate Help topic)

(c) Sparx Systems 2022
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